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ET-PIC 24 WEB-V1
 

 

 ET-PIC 24 WEB-V1  เปนบอรดไมโครคอนโทรลเลอรในตระกูล PIC  ของบริษัท Microchip  โดยไดนําเอา
ไมโครคอนโทรลเลอรที่ประมวลผลขอมูลแบบ 16 บิต เบอร PIC24FJ128GA008 มาพัฒนาเปนบอรดใชงาน ซึ่ง
คุณสมบัติเดนของ PIC24FJ128GA008 ก็ คือ ความเร็ว และ ทรัพยากรตางๆ  ดังตอไปนี้ 
 

o หนวยประมวลผล  (CPU)  

• ความเร็วในการประมวลผล 16 MIPS  

• ฮารดแวรรองรับการคูณขอมูล 16 x 16 บิต โดยใชเวลาเพียง 1 ไซเคิลคําสั่ง  

• ฮารดแวรรองรับการหารขอมูล 32-bit x 16  บิต 

• C Compiler ถูกออกแบบใหมีความกระชับ Optimized Instruction Set 

o ระบบ (System) 

• แหลงกําเนิดสัญญาณนาฬิกาภายใน 31 kHz ถึง 8 MHz และ สูงสุดถึง  32 MHz โดยใช 4X PLL 

• มีวงจร  LDO Voltage Regulator อยูภายใน 

• รองรับ JTAG Boundary Scan และ  Flash Memory Program Support 

• มีระบบตรวจสอบสัญญาณนาฬิกา (Fail-Safe Clock Monitor – allows safe shutdown if clock fails) 

•  ระบบ  Watchdog Timer ที่ใชแหลงสัญญาณนาฬิกาแบบ RC oscillator ที่แยกจากสวนอ่ืนๆ 

• ทํางานที่แรงดันระดับ 2.0 ถึง 3.6 โวลต  

o การจัดการดานพลังงาน โดยเทคโนโลยีนาโนวัตต  (nanoWatt Power Managed Modes) 

• รองรับโหมดการทํางานแบบ  Run, Idle และ  Sleep modes  

• สามารถปรับเปลี่ยนโหมดการทํางานของสัญญาณนาฬิกาไดหลากหลายเพื่อประสิทธิภาพ และ ให

สอดคลองกับการดูแลจัดการในเรื่องของพลังงาน 

o คุณสมบัติทางดานสัญญาณอนาลอก (Analog Features) 

• โมดูลแปลงสัญญาณ Analog to Digital ความละเอียด 10-bit จํานวน 16 ชอง  ความเร็วในการแซมเปล

สัญญาณ  500 Kbit  ตอวินาที 

• โมดูลเปรียบเทียบแรงดันอนาลอก (Analog comparators) จํานวน  2 ชอง  

 
 
 
 



คูมือการใชงาน ET-PIC 24 WEB-V1 

 
-2-

o คุณสมบัติอื่นๆ ของ PIC24FJ128GA008 

• โมดูลการสื่อสาร UART จํานวน 2 ชอง บัฟเฟอรเปนแบบ FIFO ความลึก   4 ชั้น 

• โมดูลการสื่อสารแบบ SPI จํานวน 2 ชอง บัฟเฟอรเปนแบบ FIFO ความลึก   8 ชั้น 

• โมดูลการสื่อสารแบบ  I2C™ จํานวน 2 ชองรองรับทั้ง  Master และ  Slave Modes 

• โมดูล Timer ขนาด  16-bit จํานวน 5 โมดูล 

• โมดูล Capture , Compare / PWM  จํานวน 5 ชุด 

• ระบบฮารดแวร  RTCC, Real-Time Clock Calendar with Alarms ภายใน 

• ระบบการสื่อสารแบบขนาน PMP, Parallel Master Port, with 16 Address Lines, and 8/16-bit Data 

• หนวยความจําโปรแกรมแบบ Flash Memory ขนาด 128 KBytes 

• หนวยความจําขอมูล SRAM  ขนาด  8 Kbytes 

• I/O ports จํานวน 70 บิต 

 คุณสมบัติโดยท่ัวไปของบอรด  ET-PIC 24 WEB 

- ใชไมโครคอนโทรเลอร PIC24FJ128GA008 ขนาด 80 PIN  

- สัญญาณนาฬิกาคริสตอลออสซิลเลเตอรขนาด  8 MHz  (สามารถใช  x4PLL รันไดถึง 32 MHz)   

- I/O Port  ขนาด 10 PIN (จัดเรียงตามมาตรฐานของ อีทีที) จํานวน 9 พอรต 

- ชุดวงจรไดรเวอร  RS232 จํานวน 2 พอรต 

- พอรตสําหรับตอ LCD เรียงตามมาตรฐานของ อีทีที (ET-CLCD) จํานวน 1 พอรต 

- ขั้วตอสัญญาณดาวนโหลดโปรแกรมแบบ ICD2 และ สวิตชตัดตอสัญญาณ Run / Program 

- วงจร LED สําหรับใชทดลองเอาตพุตจํานวน 8 ชอง 

- วงจรสวิตช BUTTON สําหรับใชทดลองอินพุตจํานวน 4 ชอง 

- วงจรสรางแรงดัน 0-3.3V จากตัวตานทานปรับคาได สําหรับทดลองโมดูล A/D จํานวน 1 ชอง 

- พอรตเชื่อมตอกับหนวยความจํา EEPROM 25LCxxx จํานวน 1 ชอง  
- พอรตสําหรับเชื่อมตอกับโมดูลอินเตอรเน็ต ET-MINI ENC28J60  

- ชุดเรกูเรเตอรแบบสวิตชชิ่ง สําหรับแปลงสัญญาณไฟ DC Input ใหเปน 3.3 V 

- ขั้วตอแรงดันไฟ VCC และ GND 
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โครงสรางบอรด ET-PIC 24 WEB-V1 

 

 
 

อธิบายรายละเอียดตามหมายเลขไดดังตอไปนี้  
 

• หมายเลข  1  พอรตเชื่อมตอสัญญาณแบบ RS-232 จํานวน 2 พอรต มีวงจรการเชื่อมตอดังตอไปนี้ 
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1 2

3 4

5 6

7 8

9 10

RE0 RE1
RE2 RE3
RE4 RE5

+3.3V GND

PORTE-L

RE6 RE7

 

 

• หมายเลข  2    พอรต ET-LCD สําหรับเชื่อมตอกับจอแสดงผล LCD แบบตัวอักษร (Character LCD) โดยมี
การจัดวางขาสัญญาณตางๆ ดังตอไปนี้ 

 

 
 

• หมายเลข  3 , 4 , 5 , 6 , 7, 8 , 9, 10  และ 11    คือ พอรต I/O ของไมโครคอนโทรเลอร ที่ถูกออกแบบใหอยู
ในรูปแบบของพอรตมาตรฐาน 10-PIN ETT โดยในแตละพอรตมีการจัดเรียงสัญญาณดังตอไปนี้ 
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• หมายเลข 12   พอรตสัญญาณ I/O ขนาด 4 PIN ประกอบดวยสัญญาณ RE8,RE9,RF8 และ GND ดังตอไปนี้ 
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• หมายเลข 13  ขั้วตอสําหรับดาวนโหลดโปรแกรม เปนขั้วที่จัดเรียงตามมาตรฐานของ ICD2 รองรับเคร่ือง
โปรแกรมที่มีการเชื่อมตอตามมาตรฐานของ ICD2  เชน  PICKit2 , ICD2 และ เคร่ืองโปรแกรมของทาง
บริษัท อีทีที คือ ET-PGMPIC USB โดยกอนทําการโปรแกรมทุกคร้ังตองกดสวิตช MODE ใหมาอยูที่
ตําแหนง PGM ทุกคร้ัง เพื่อตัดตอขาสัญญาณมาเขากับเคร่ืองโปรแกรมจากภายนอก 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 14  สวิตชเลือกโหมด RUN และ PGM สวิตชน้ี เมื่อกดมาที่ตําแหนง PGM จะทําหนาที่ตัดตอ
ขาสัญญาณที่ใชในการโปรแกรมโคดขอมูลเขากับเคร่ืองโปรแกรม เพื่อทําการโปรแกรมขอมูลโปรแกรมที่
เราออกแบบ  และ เมื่อกดปลอยกลับมาที่ตําแหนง RUN ขาสัญญาณตางๆ จะกลับมาเปน I/O ใชงานไดตาม
ปรกติ 

 

 
 

• หมายเลข  15  ขั้วตอ DC-JACK สัญญาณไฟเลี้ยงบอรด รองรับแรงดันไฟจากภายนอก 9-12 VDC 

• หมายเลข  16  สวิตชรีเซต (Reset Switch) 
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RG6 (SCK) RG7(SO)
RG8 (SI) RD12 (CS)

NC NC

+3.3V GND

SPI MEMORY

NC NC

 

จัมเปอรสําหรับการเลือกการเชื่อมตอสัญญาณ RE8,RD15 และ RE9 ของ
ไมโครคอนโทรลเลอร กับขาสัญญาณ INT,RST และ WOL ของโมดูล 
ET-MINI ENC28J60  

   DIS = Disable คือ ไมเชื่อมตอสัญญาณ 

   EN  = Enable  คือ เชื่อมตอสัญญาณ 

• หมายเลข  17  ไอซีไมโครคอนโทรเลอร PIC24FJ128GA008  ขนาด 80-Pin 

• หมายเลข  18   หนวยความจํา EEPROM เบอร 25LCxxx ของ บริษัท Microchip เชื่อมตอแบบ SPI   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 19  ขั้วสัญญาณเชื่อมตอกับโมดูลสื่อสารอินเตอรเน็ต  ET-MINI ENC28J60 
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2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

 

• หมายเลข 20   ชุด Test I/O LED ประกอบดวยหลอดไฟ LED จํานวน 8 ชุด ดังวงจรตอไปนี้ 
 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 21  ชุดทดลองสัญญาณอินพุท จากสวิตช 4 ชุด สามารถสรางสัญญาณลอจิก 0 (0 โวลท) และ 
ลอจิก    1  ( +3.3 โวลท)  ดังวงจรตอไปนี้ 

 

 

 

 

 

 

 

 

• หมายเลข 22  ชุดทดลองแรงดันอนาลอก 4 ชุด สามารถปรับระดับแรงดันไฟไดตองแต 0 – 3.3 โวลท โดยมี
การตอวงจรดังตอไปนี้  

 

 

 

 

 

 

• หมายเลข 23   พื้นที่อเนกประสงค สําหรับตอวงจรเพิ่มเติม  
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โมดูล ET-MINI ENC28J60   

ET-MINI ENC28J60  เปนโมดูลที่ออกแบบมาเพื่อเปนตัวกลางในการเชื่อมตอระบบการสื่อสารระหวาง
ไมโครคอนโทรลเลอร กับโครงขาย Ethernet รองรับการทํางานของโปรโตคอล TCP/IP  โดยใชไอซี ENC28J60 ซึ่ง
เปนไอซี Ethernet Controller รองรับมาตรฐานการสื่อสาร IEEE 802.3 เชื่อมตอสัญญาณควบคุมผาน SPI Bus 

ความเร็วสูงสุด 10 Mb/s ในการพัฒนาโปรแกรมทางบริษัท Microchip จะสนับสนุนตัว Microchip TCP/IP Stack  

ซึ่งสามารถดาวนโหลด และ นําไปใชไดฟรีที่เว็ปไซตของ Microchip (www.microchip.com)  โดยคุณสมบัติคราวๆ 
ของ ENC28J60 จะเปนดังนี้ 
 

คุณสมบัติของ IC ENC28J60  

General: 

- IEEE 802.3 compatible Ethernet Controller 

- Integrated MAC and 10BASE-T PHY 

- 8 Kbyte Transmit/Receive Packet Dual Port Buffer SRAM 

- Programmable Automatic Retransmit on Collision 

- Programmable Padding and CRC Generation 

- Programmable Automatic Rejection of Erroneous Packets 

- SPI™ Interface with speeds up to 10 Mb/s 

- Supports Full and Half-Duplex modes 

Buffer: 

- Configurable transmit/receive buffer size 

- Hardware managed circular receive FIFO 

- Byte-wide random and sequential access 

- Internal DMA for fast memory copying 

- Hardware assisted IP checksum calculation 

PHY: 

- Wave shaping output filter 

- Loopback mode 

MAC: 

- Support for Unicast, Multicast and Broadcast packets 

- Programmable pattern matching of up to 64 bytes within packet at user defined offset 

- Programmable wake-up on multiple packet formats,including Magic Packet®, Unicast, Multicast, Broadcast, 

specific packet match or any packet 
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 การเชื่อมตอกับไมโครคอนโทรลเลอร สามารถทําไดโดยงาย โดยจะใชการเชื่อมตอแบบ SPI Bus ซึ่งจะใช
ขาสัญญาณเพียงไมกี่ขา และ ในสวนของระบบไฟ เนื่องจาก ENC28J60 เปนไอซีที่ทํางานที่แรงดัน 3 โวลท ดังนั้น
เพื่อใหสามารถใชงานไดกับไมโครคอนโทรลเลอรที่ทํางาน 5 โวลท ทางทีมงานจึงไดออกแบบ วงจรบัฟเฟอร 
สําหรับรองรับการเชื่อมตอระบบไฟ ระหวาง 3 โวลท กับ 5 โวลท เอาไวภายในบอรด ET-MINI ENC28J60  ซึ่ง
สามารถเลือกระบบไฟไดโดยการเลือก จัมพเปอร  5V/3V3   

 

 

 
 

 
 

รูปแสดงบล็อกไดอะแกรมการเชื่อมตอ ENC28J60  กับ ไมโครคอนโทรลเลอร 
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+5V

+3.3V

VDD

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปแสดงโครงสรางของบอรด ETMINI  ENC28J60  
 

 จากรูป HD1 และ HD2  ออกแบบไวสําหรับการเชื่อมตอกับบอรด ET-PIC 24 WEB สวน HD3  ออกแบบ
สําหรับนําไปใชเชื่อมตอกับ ไมโครคอนโทรเลอรอ่ืนๆ โดยจะออกแบบในลักษณะของ ET-MINI ของ อีทีที 

 

 

 

คําเตือน : จะตองเลือกจัมเปอรให
ถูกตองตามการใชงานจริงไมเชนนั้น
อาจเกิดความเสียหายแกอุปกรณได
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ตาราง แสดงชื่อและหนาที่ขาสัญญาณตางๆ ของ  ENC28J60  

ชื่อขาสัญญาณ ชนิดของขาสัญญาณ หนาท่ีการทํางาน 

CS INPUT สัญญาณ Enable/Disable การเชื่อมตอ SPI Bus ของ ENC28J60 

        CS = 0  คือ Enable การเช่ือมตอสัญญาณ SPI ของ ENC28J60 

        CS = 1  คือ Disable การเช่ือมตอสัญญาณ SPI ของ ENC28J60 

SDO OUTPUT สัญญาณ Serial Data Output  

SDI INPUT สัญญาณ Serial Data Input 

SCK INPUT สัญญาณนาฬิกา  Serial Clock 

INT OUTPUT สัญญาณอินเตอรรัพท แอคทีฟ ลอจิก 0 

RST INPUT สัญญาณรีเซต แอคทีฟ ลอจิก 0 

WOL OUTPUT สัญญาณ Wake-up on LAN interrupt  แอคทีฟ ลอจิก 0 

CLKO OUTPUT สัญญาณ Programmable clock output 

LEDA OUTPUT แสดงสถานะของสัญญาณ  LINK 

LEDB OUTPUT แสดงสถานะของสัญญาณ   ACT 

 

    

ตารางแสดง สัญญาณการเชื่อมตอระหวางบอรด ENC28J60 กับ ET-PIC24 WEB 

ENC28J60 ET-PIC24WEB (PIC24FJ128GA008) 

CS RD14 

SDO RF8 

SDI RF7 

SCK RF6 

INT RE8 (เลือกโดยจัมเปอร) 
RST RD15 (เลือกโดยจัมเปอร) 
WOL RE9 (เลือกโดยจัมเปอร) 
CLKO - 

LEDA - 

LEDB - 
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สรุปการจัดสรรและใชงานทรัพยากรของบอรด ET-PIC24WEB V1.0 

 

 ตามปรกติแลว MCU เบอร PIC24FJ128GA008 ที่ใชกับบอรด ET-PIC24 WEB V1.0 น้ัน จะมีขาสัญญาณ

ใหใชงานไดโดยอิสระมากถึง 69 I/O แตจะมีขาสัญญาณบางสวน ถูกออกแบบและเชื่อมตอไวกับอุปกรณ I/O เปน

การเฉพาะไวเรียบรอยแลว ไมสามารถนํามาใชเปน I/O โดยทั่วไปได ซึ่งพอสรุปไดดังนี้ 

 

MCU Oscillator 

• RC12 ใชเปน OSC1 ตอกับ Crystal คา 8.00MHz สําหรับใชเปนสัญญาณนาฬิกาของ MCU 

• RC15 ใชเปน OSC2 ตอกับ Crystal คา 8.00MHz สําหรับใชเปนสัญญาณนาฬิกาของ MCU 

 

RTC Oscillator 

• RC13 ใชเปน OSC1 ตอกับ Crystal คา 32.768KHz สําหรับใชเปนสัญญาณนาฬิกาของ RTC 

• RC14 ใชเปน OSC2 ตอกับ Crystal คา 32.768KHz สําหรับใชเปนสัญญาณนาฬิกาของ RTC 

 

พอรตสื่อสารอนุกรม(UART) RS232-CH1 

• RF2 ใชเปนขา RXD สําหรับรับขอมูลจาก RS232 ชอง-1 

• RF3 ใชเปนขา TXD สําหรับสงขอมูลให RS232 ชอง-1 

 

พอรตสื่อสารอนุกรม(UART) RS232-CH2 

• RF4 ใชเปนขา RXD สําหรับรับขอมูลจาก RS232 ชอง-2 

• RF5 ใชเปนขา TXD สําหรับสงขอมูลให RS232 ชอง-2 

 

Ethernet Module (SPI-1) 

• RF6 ใชเปน SCK ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RF7 ใชเปน SDI ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RF8 ใชเปน SDO ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RD14 ใชเปน CS ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RE8 ใชเปน INT1 ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) โดยสามารถเลือกใชหรือไม

ใชได โดยการกําหนดที่ Jumper INT(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 

• RE9 ใชเปน WOL ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60)โดยสามารถเลือกใชหรือไม

ใชได โดยการกําหนดที่ Jumper WOL(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 

• RD15 ใชเปน RST ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60)โดยสามารถเลือกใชหรือไม

ใชได โดยการกําหนดที่ Jumper RST(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 
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SPI Memory Module (SPI-2) 

• RG6 ใชเปน SCK ในการเชื่อมตอกับ SPI Memory 

• RG7 ใชเปน SDI ในการเชื่อมตอกับ SPI Memory 

• RG8 ใชเปน SDO ในการเชื่อมตอกับ SPI Memory 

• RD12 ใชเปน CS ในการเชื่อมตอกับ SPI Memory 

 

Character LCD Display 

• RE0 ใชเปน LCD D4 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE1 ใชเปน LCD D5 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE2 ใชเปน LCD D6 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE3 ใชเปน LCD D7 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE4 ใชเปน LCD RS ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE5 ใชเปน LCD RW ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE6 ใชเปน LCD EN ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

 

LED[1..8] ในการทดลอง Web Server Control 

• RD0..RD7 ใชเปน Digital Output โดยตอกับ LED[1..8] 

 

SW[1..4] ในการทดลอง Web Server Control 

• RD8..RD11 ใชเปน Digital Input โดยตอกับ Switch[1..4] 

 

ADC Input ในการทดลอง Web Server Control 

• RB5(AN5) ใชเปน ADC0 ในการอานคา Input ของ Analog to Digital ขนาด 10 Bit โดยตอกับ VR1 
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แนะนําการใชงาน MPLAB C30 เบื้องตน 
 

 เปดโปรแกรม MPLAB IDE โดยคลิกที่ Start -> Microchip -> MPLAB IDE v7.61 -> MPLAB IDE หรือ 
ดับเบิลคลิกที่ ไอคอน MPLAB IDE หนา Desktop  ดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.  จะปรากฏหนาตางโปรแกรม MPLAB IDE v7.61 ดังรูป 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

หรือ ดับเบิลคลิกที่   
ไอคอน MPLAB IDE 
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 ทําการสรางโปรเจคโดยเลือกที่ Project -> Project Wizard.. 

 

 
 

 

 จะปรากฏหนาตาง Project Wizard ใหคลิกเลือก Next > เพื่อทําขั้นตอนตอไป 
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 เลือกอุปกรณในชอง Device: ใหตรงบอรด ในที่น้ีคือ PIC24FJ128GA008 จากนั้น คลิก Next >  
 

 
 

 เลือก คอมไพลเลอรที่ใช ในที่น้ีคือ  MPLAB C30 C Compiler (pic30-gcc.exe) จากนั้นคลิก Next > 
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 คลิก Browse ไปที่โฟลเดอรที่ตองการเก็บโปรเจค เชน สรางโฟลเดอรชื่อ PIC24_Start  ตามตัวอยาง แลว 
Browse.. เขาไปที่โฟลเดอรดังกลาว ทําการตั้งชื่อโปรเจ็ค ตัวอยางนี้จะตั้งชื่อวา Demo1 แลว Save 

 

 
 

 จะปรากฏหนาตางที่เราสามารถ Add หรือ Removeไฟลโคดตางๆ ในโปรเจ็ค กรณีที่มีไฟลโคดอยูแลว แต
ถาไมมี ก็ใหคลิก Next > เพื่อเขาสูขั้นตอนถัดไป  

 

 

 

 

 

 

 

 

 

 

 

 



คูมือการใชงาน ET-PIC 24 WEB-V1 

 
-19-

 จะปรากฏหนาตางสรุป คา พารามิเตอร ตางๆ ของโปรเจคที่เราไดสรางขึ้น ใหตรวจสอบความถูกตองแลว 
คลิก Finish  เพื่อจบขันตอนของ Project Wizard 

 

 
 

 โดยจะเขาสูหนาตางหลักของ MPLAB ใหเราคลิกที่ View -> Project  
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 จะปรากฏหนาตางแสดงโครงสรางไฟลของโปรเจ็คดังรูป 

 

 
 

 คลิกเลือก File -> New  เพื่อสรางไฟลซอรสโคด 
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 จะปรากฏหนาตางวางเปลาใหชื่อ Untitled ดังรูป  
 

 
 

 ใหเราเลือก File -> Save As…  เพื่อทําการบันทึกใหเปนไฟล  . C  

 

 
 

 ใหต้ังชื่อไฟลตามดวยนามสกุล  .C ในตัวอยางนี้คือ Demo1.C และ เลือก Save as type : เปน C Source Files 

(*.c,*.h) ดังรูปดานลาง 
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 เราจะไดไฟล Demo1.c เกิดขึ้นมา ใหทําการพิมพโคดโปรแกรมลงไปในไฟลดังกลาว ดังตัวอยางตอไปนี้ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 จากนั้นทําการบันทึก  File -> Save 
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 ทําการ Add ไฟลซอรสโคดที่เราสรางขึ้นไปไวในโปรเจค โดยคลิกขวาที่  Source File แลวเลือก Add Files.. 

 

 
 

 จะปรากฏหนาตาง Add Files to Project ใหเราคลิกซายที่ไฟลซอรสโคด ในตัวอยางนี้คือ Demo1 จากนั้น
คลิก Open  
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 จะเห็นวาใน Source Files จะปรากฏไฟลชื่อ Demo1.c  

 

 
 

 จากนั้นทําการ Add  ไฟล Linker Scripts โดยคลิกขวาที่ Linker Scripts แลว เลือก Add Files.. 

 

 
 

 จะปรากฏหนาตาง Add Files to Project ใหคลิกเลือกไฟล p24FJ128GA008.gld ซึ่งจะอยูในโฟลเดอร ดังนี้ 
               C:\Program Files\Microchip\MPLAB C30\support\gld 
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 เมื่อเรียบรอยแลวเราจะเห็นไฟล p24FJ128GA008.gld ถูก Add เขามาใน Linker Scripts ดังรูป 

 

 
 

 

 ตอไปทําการคอมไพลโปรเจ็คโดยคลิกเลือก Project -> Build All  ดังรูป 
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 โดยจะมีการรายงานผลของของการคอมไพลในหนาตาง Output -> Build หากการคอมไพลสมบูรณจะมี
ขอความ BUILD SUCCEEDED ดังรูป 

 

 
 

 โดยจะปรากฏไฟล Demo1.Hex ในโฟลเดอรเดียวกับโปรเจคที่เราสรางขึ้นดังรูป 
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 การโปรแกรมซอรสโคด (Code Programming)  
 หลังจากที่ได Hex File แลวตอไปการโปรแกรมขอมูลโคดโปรแกรมลงไปในไมโครคอนโทรลเลอรของ
บอรด ET-PIC 24 WEB จะตองอาศัยเคร่ืองโปรแกรมจากภายนอก เชน ICD2 ,PICKit 2 หรือ เคร่ืองโปรแกรม ET-

PGM USB ของบริษัท อีทีที  ซึ่งสามารถทําไดโดยการตอสายสัญญาณโปรแกรมเขาไปที่ขั้วตอ ICD2 ดังรูปตอไปนี้ 
 

 

 
 

 
 

 กดสวิตช MODE มาที่ตําแหนง PGM 

 

 
 

 

ET-PGMPIC USB

ET- PIC24WEB
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 เปดโปรแกรม PICkit 2 Programmer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 เลือก Device Family -> PIC24 
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 หากการเชื่อมตอเรียบรอย จะพบเบอร Device: เปน PIC24FJ128GA008 ดังรูป โดยในขั้นแรกใหทําการ 
Erase เพื่อทําการลบ Program Memory เกาออกกอน 

 

 
 

 จากนั้นทําการ Import ไฟล .HEX โดยคลิกที่ File -> Import  แลวเขาไปในโฟลเดอร PIC24_Start เลือกไฟล 
Demo1.Hex แลว Open 
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 จากนั้นจะปรากฏขอความ Hex file successfully imported  ใหเราคลิก Write เพื่อทําการโปรแกรม Hex code 

ลงไปในหนวยความจําของไมโครคอนโทรลเลอร 
 

 
 

 เมื่อการโปรแกรมเสร็จสมบูรณจะปรากฏขอความ Programming Successful. ดังรูป 
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 กดเลือกสวิตช MODE มาที่ตําแหนง Run 

 

 
 

 ตอฮารดแวรเพื่อทดสอบผลการทํางานของโปรแกรมดังนี้ 
 

PIC24FJ128GA008 LED 

RD0 LED1 

RD1 LED2 

RD2 LED3 

RD3 LED4 

RD4 LED5 

RD5 LED6 

RD6 LED7 

RD7 LED8 

 

 โดยจะเห็นหลอดไฟ LED ติดทีละดวงเริ่มจาก LED1 ไปจนถึง LED 8 

 



1 2 3 4 5 6

A

B

C

D

654321

D

C

B

A

Title

Number RevisionSize

B

Date: 5-Jul-2007 Sheet    of 
File: C:\Documents and Settings\adminstrator\My Documents\PCB\ET-PIC24WEB V1_2\PIC24_WEB.DdbDrawn By:

PMD5/RE5 1

PMD6/RE6 2

PMD7/RE7 3

T2CK/RC14

T4CK/RC35

PMA5/SCK2/CN8/RG6 6

PMA4/SDI2/CN9/RG7 7

PMA3/SDO2/CN10/RG8 8

MCLR9

V
SS

11

V
D

D
12

TMS/INT1/RE8 13

TDO/INT2/RE9 14

C1IN+/AN5/CN7/RB515 C1IN-/AN4/CN6/RB416 C2IN+/AN3/CN5/RB317 C2IN-/AN2/SS1/CN4/RB218 PGC1/EMUC1/AN1/CN3/RB119 PGD1/EMUD1/AN0/CN2/RB020

PMA2/SS2/CN11/RG9 10

PGC2/EMUC2/AN6/OCFA/RB621

PGD2/EMUD2/AN7/RB722

PMA7/VREF-/RA923

PMA6/VREF+/RA1024 A
V

D
D

25

A
V

SS
26

U2CTS/C1OUT/AN8/RB827

C2OUT/AN9/RB928

PMA13/CVREF/AN10/RB1029

PMA12/AN11/RB1130

V
SS

31

V
D

D
32

TCK/PMA11/AN12/RB1233

TDI/PMA10/AN13/RB1334

PMA1/U2RTS/BCLK2/AN14/RB1435

PMA0/AN15/OCFB/CN12/RB1536

CN20/U1CTS/RD14 37

CN21/U1RTS/BCLK1/RD15 38

PMA9/U2RX/CN17/RF4 39

PMA8/U2TX/CN18/RF5 40

SOSCO/T1CK/CN0/RC1460

SOSCI/CN1/RC1359

OC1/RD0 58

IC4/PMCS1/RD11 57IC3/PMCS2/RD10 56IC2/RD9 55IC1/RTCC/RD8 54

SDA2/INT4/RA1553 SCL2/INT3/RA1452

V
SS

51

OSC2/CLKO/RC1550

OSC1/CLKI/RC1249

V
D

D
48

SCL1//RG2 47

SDA1/RG3 46

SCK1/INT0/RF6 45

SDI1/RF7 44

SDO1/RF8 43

U1RX/RF2 42

U1TX/RF3 41

OC2/RD1 61

OC3/RD2 62

PMBE/OC4/RD3 63

IC5/RD12 64

CN19/RD13 65

PMWR/OC5/CN13/RD4 66

PMRD/CN14//RD5 67

CN15/RD6 68

CN16/RD7 69

V
C

A
P/

V
D

D
C

O
R

E
70

EN
V

R
EG

71

RF0 72

RF1 73

RG1 74RG0 75

PMD0/RE0 76

PMD1/RE1 77

PMD2/RE2 78

PMD3/RE3 79

PMD4/RE4 80

U2
PIC24FJ128GA008

C11

10uF

C10

0.1uF

+3.3V

C6
0.1uF

C7
0.1uF

C8
0.1uF

C9
0.1uF

+3.3V

X1
8MHz

C13
22pF

C14
22pF

1 2
3 4
5 6
7 8
9 10

CN3

PORTA

1 2
3 4
5 6
7 8
9 10

CN5

PORTB-L

1 2
3 4
5 6
7 8
9 10

CN7

PORTB-H

1 2
3 4
5 6
7 8
9 10

CN9

PORTC

1 2
3 4
5 6
7 8
9 10

CN10

PORTD-L

1 2
3 4
5 6
7 8
9 10

CN11

PORTD-H

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

RA9
RA10
RA14
RA15

RA9
RA14

RA10
RA15

RB0
RB1
RB2
RB3
RB4
RB5

RB8
RB9
RB10
RB11
RB12
RB13
RB14
RB15

RB0
RB2
RB4
RB6

RB8
RB10
RB12
RB14

RB1
RB3
RB5
RB7

RB9
RB11
RB13
RB15

RC1
RC3

RC1 RC3
RC14RC13

RD0
RD1
RD2
RD3
RD4
RD5
RD6
RD7
RD8
RD9
RD10
RD11
RD12
RD13
RD14
RD15

RD0
RD2
RD4
RD6

RD8
RD10
RD12
RD14

RD9
RD11
RD13
RD15

RD1
RD3
RD5
RD7

1 2
3 4
5 6
7 8
9 10

CN13

PORTE-L

+3.3V

RE0
RE2
RE4
RE6

RE1
RE3
RE5
RE7

RE0
RE1
RE2
RE3
RE4
RE5
RE6
RE7
RE8
RE9

RF0
RF1
RF2
RF3
RF4
RF5
RF6
RF7
RF8

1 2
3 4
5 6
7 8
9 10

CN4

PORTF-L

+3.3V

RF0
RF2
RF4
RF6

RF1
RF3
RF5
RF7

RG0
RG1
RG2
RG3
RG6
RG7
RG8
RG9

1 2
3 4
5 6
7 8
9 10

CN6

PORTG

+3.3V

RG0
RG2
RG6
RG8

RG1
RG3
RG7
RG9

RE8
RE9

1 2
3 4
5 6
7 8
9 10
11 12
13 14

CN12

ET-CLCD

VR2

10K

+5V

RE4
RE6

RE1
RE3 RE2

RE0

RE5

+V GND
RS VO
EN RW

D0D1
D2D3
D4D5
D6D7

1
2
3
4
5
6

CN14
ICD2

C12
0.1uF

R18
4K7

+3.3V

+3.3V

RB6

RB7

C1+ 1

C1- 3

C2+ 4

C2- 5

R1O 12

T1I 11

R2O 9

T2I 10

VCC16

V+2

V-6

GND15

R1I13

T1O14

R2I8

T2O7

U1
ICL3232

1
2
3
4

CN2
RS232-CH2

1
2
3
4

CN1
RS232-CH1

+3.3V

+3.3V

C1
0.1uF

+3.3V

C2
0.1uF

C4
0.1uF

C3
0.1uF

C5
0.1uF

IN3

G
N

D
1

OUT 2

U4
AP1117-5.0

C21
0.1uF

C23
0.1uFC20

220uF/25V
C22

47uF/16V

J1
7-12VDC +5V

X2

32.768kH
z

C16
22pF

C15
22pF

R
C

13

R
C

14

1 2
3 4
5 6
7 8
9 10

HD3
SPI MEMORY

LED11
POWER

R22
470

+3.3V

+3.3V

SW6
RESET

RG6
RG8

RG7
RD12

1
2
3
4
5
6
7
8

HD1

1
2
3
4
5
6
7
8

HD2 +3.3V

RF8
RF6
RF7
RD14

RF2
RF3

RF5
RF4

JP1

JP2

RD15

RE8

ET-MINI ENC28J60 JP3

RE9

1

3
2

4

6
5

7

9
8

10

12
11

SW5
MODE

RUN

PROG

LED9
PGM

LED10
RUN

R15

470

+3.3V

R19
1M

1
2
3
4

CN8

HEADER 4

RF8

R20
NL

R21
NL

R16 1K

R17 100

R13
470

R14
470

IN1 FB 4

OUT 2

G
N

D
3

O
N

/O
FF

5

U3
LM2575-3.3

L1

220uH

D2
1N5819

C18
0.1uF/50V

D1

1N4001

C19
100uF/16V C17

10uF/16V

+3.3V



1 2 3 4

A

B

C

D

4321

D

C

B

A Title

Number RevisionSize

A4

Date: 5-Jul-2007 Sheet    of 
File: C:\Documents and Settings\adminstrator\My Documents\PCB\ET-PIC24WEB V1_2\PIC24_WEB.DdbDrawn By:

LED
1

R1

470

+3.3V
SW

2

R10

10K

LED
2

R2

470

LED
3

R3

470

LED
4

R4

470

VR1
10K

SW
1

R9

10K

SW
3

R11

10K

SW
4

R12

10K

LED
5

R5

470

LED
6

R6

470

LED
7

R7

470

LED
8

R8

470

+3.3V +3.3V

1
2

HD6

HEADER 2

1
2

HD9

HEADER 2

1
2

HD8

HEADER 2

1
2

HD7

HEADER 2

1
2

HD5

HEADER 2

1 2 3 4 5 6 7 8

HD4
HEADER 8



1 2 3 4

A

B

C

D

4321

D

C

B

A Title

Number RevisionSize

A4

Date: 12-Jul-2007 Sheet    of 
File: C:\Documents and Settings\adminstrator\My Documents\PCB\ET-MINI ENC28J60\ET-MINI ENC28J60.ddbDrawn By:

8

1

4

2

3

5

6

7

CHS GNDNC

1CT:1

TD+

TD-

CT

RD+

CT

RD-

TX+

TX-

RX+

RX-
6

3

2

1

4
5

7
8

J1
RJ45_PRJ-005

R11

2K7  1%

C11

10uF

VDD

C3

0.1uF

C4

0.1uF

C5

0.1uF

C6

0.1uF

C7

0.1uF

VDD

VDD 28

VDDOSC 25

VDDPLL 20

VDDRX 19

VDDTX 15

VCAP 1

TPOUT+ 17

TPOUT- 16

TPIN+ 13

TPIN- 12

LEDA 27

LEDB 26

RBIAS 14VSSRX11 VSSTX18 VSSPLL21 VSSOSC22 VSS2

WOL5 INT4

OSC123

OSC224 CLKOUT3

RESET10 CS9 SCK8 SI7 SO6
U1

ENC28J60-SOIC

X1
25MHz

C12
33pF

C13
33pF

R6 180
R5 180

R7 180
R8 180

R2 50

R3 50

L1

FB

C2

0.1uF

R1 50

R4 50

C1

0.1uF

VDD

SDO
SCK
CS
RST

LINT
LWOL

LSO

TPOUT+

TPOUT-

TPIN+

TPIN-

TPOUT+
TPOUT-
TPIN+
TPIN-

LED2

LINK

LED1

ACT

R9180
R10180

LCLKOUT 2 3

1

U2A
74AHC125

5 6

4

U2B
74AHC125

9 8

10

U2C
74AHC125

12 11

13

U2D
74AHC125

LCLKOUT CLKO

LINT

LWOL WOL

INT

SDI

LCS

LSO

LCS

14
7

VCC

C8
0.1uF

VCC

IN

G
N

D

OUT

U3
LM3940-3.3

C9
0.1uF

C10
0.1uF

C14
47uF/16V

JP1
Voltage Selection

VDD

VCC

LED3
PWR

R12
330

VDD

1
2
3
4
5
6
7
8
9
10

HD3VCC

CS
SDO
SDI
SCK

RST
INT

WOL
CLKO

VCC

RST
INT

WOL
CS

SDO

SDI
SCK

ET-MINI ENC28J60

U2

1
2
3
4
5
6
7
8

HD1

1
2
3
4
5
6
7
8

HD2

CLKO

1-2=5V
2-3=3.3V

1
2
3

ZD1
3V6

LEDA
LEDB

LEDB
LEDA

VDD



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (Photoshop 5 Default CMYK)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <FEFFd5a5c0c1b41c0020c778c1c40020d488c9c8c7440020c5bbae300020c704d5740020ace0d574c0c1b3c4c7580020c774bbf8c9c0b97c0020c0acc6a9d558c5ec00200050004400460020bb38c11cb97c0020b9ccb4e4b824ba740020c7740020c124c815c7440020c0acc6a9d558c2edc2dcc624002e0020c7740020c124c815c7440020c0acc6a9d558c5ec0020b9ccb4e000200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee563d09ad8625353708d2891cf30028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f003002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c4fbf65bc63d066075217537054c18cea3002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f3002>
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


